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Introduction

With the introduction of Windows 8 Microsoft relies on the tiles concept for structured visualization of programs,
apps and information on the home screen. Even SAP has taken up this idea, and with SAP Fiori, they have created
a simple user interface that is build on this tile concept - adapted to the needs of operational business applications.

It was therefore obvious for us to develop a tile solution for Business Intelligence (BI) — the more so as our
customers have signalled a demand. They wanted a start screen for dashboards that clearly represents the key
performance indicators (KPIs).

From this highly aggregated view the user should jump — in terms of a pre-defined navigation path — on graphical
overviews or detailed table views created with our graphomate charts and graphomate tables — see Figure below —
from starting point to detalil
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After a first gathering of the customer requirements pertaining to a tile solution it was obvious that there is no single
tile that can be used for all purposes: too different were the demands on the visual requirements. The solution had to
be a modular construction kit, which allows users to combine different tile modules on a pre-defined layout.

The guestion remained how to create a uniform design of these modules and the whole tile. Here we were able to
draw on the great work of John Armitage: his design proposals for analytical tiles were our aesthetic standard for a
consistent style. His book “Bringing Numbers to Life: Lava and Design-Led Innovation in Visual Analytics” should be
published in Q1 2016.

In the sense of a uniform language regulation we speak in the further manual of Lumira Designer or briefly
designer. Our products are still compatible with SAP Design Studio 1.6.

For our graphomate tiles extension Design Studio 1.6 SPOO or higher or Lumira Designer >= 2.0 and IE 11+ are
required. For further information, for example about the deployment on the Business Intelligence Platform (BIP) or
SAP Netweaver, please consult the Product Availability Matrix (PAM). Please note that from 2017, we will no longer
support Internet Explorer 9 and 10.
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Installation

® Before opening your old dashboards/BI apps with Designer 2.0, you need to migrate them to m mode

with Design Studio 1.6.

® Qur extensions for Design Studio 1.6 will also run in Designer 2.0. When starting Lumira 2.0
Designer, please do not import our graphomate extension from SAP Design Studio 1.6. Instead we
suggest using the versions specifically built for Designer 2.0.

Local installation of the extension to Designer
You have installed Designer 2.0 SP00+ on your computer.

1. Save the zipfile graphomate_tiles2.0.x.zip to a folder of your choice.

In Designer, choose Tools Install Extension to Lumira Designer, click on Archive and select the zipfile which
has been saved before.

Choose Finish to start the installation.

Choose Next and again Next to confirm the installation.

Accept the terms of the license agreement and choose Finish.

Choose Yes to allow a restart of Designer.

After the restart, the graphomate extension appears in the Component View of Designer.

N

NogMw

Removing the extension from Designer
In Designer choose Help > About....

1. Click the Installation Details button.

2. Select the component graphomate tiles 2.0.x
3. Choose Uninstall... .

4. In the UninstallWizard choose Finish.

5. Choose Yes to allow Designer to restart.
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Server installation of the extension

Users need to deploy the locally installed extension to the Bl platform before launching the graphomate tiles from
the BI platform.

ou

1. Choose in the BI Platform Mode Tools > Platform Extensions.

2. Select the extension graphomate tiles that is installed on your local computer.

3.

4. Manually restart the Bl Platform Adaptive Processing Servers that host the Analysis Application Service and

Choose Install on Platform.

accept the warnings in Designer.
The graphomate extension appears under Extensions Installed on Platform.
Choose Close.

7. Again restart the Bl Platform Adaptive Processing Servers that host the Analysis Application manually.

Uninstalling the extension from the Server

N o

1. Choose in the Bl Platform Mode Tools > Platform Extensions.
2. Choose the graphomate tiles.

3.
4
5

Choose Uninstall from Platform.

. Confirm the uninstalling by choosing Yes.
. In order to complete the uninstalling process, manually restart the Bl Platform Adaptive Processing Servers

that host the Analysis Application Service and accept the warnings in Designer.

The graphomate tiles is then removed from the Extensions Installed on Platform.

Choose Close.

Manually restart the Bl Platform Adaptive Processing Servers that host the Analysis Application Service.
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Quick Start

You have defined a Data Source and now want to depict Data Series from this query with modules of the graphomat
e tiles.

1. Drag the component graphomate tiles to the canvas and bind the Data Source to this component via
drag&drop. Unfortunately, it is only possible to assign one Data Source per tile (as for all Designer
components).

2. Now you can configure your tile on the General/Layout tab: To do this, first select a layout and afterwards
choose the desired modules and drag and drop them to the Builder. The properties for each module are then
generated in the background. You can adjust the properties on the next tab Modules.

3. There you can select via Display Dimensions which dimensions and measures from the data source should
be displayed in the modules. This option is strongly related to the chosen module (some modules do not
require the visual display of dimensions).

4. Via the Appearance tab you determine the comprehensive number format for the tile.
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Properties

Basically, you have two ways in which to change the properties of graphomate tiles:
Using the Standard Properties Sheet, that shows all the parameters in a structured list or via the Additional

Properties Sheet. The latter offers a more user-friendly Interface.

The check boxes I in front of properties in the Additional Properties Sheet are used to control the visibility of
elements and activation of functions. The data source to be used can only be assigned via Drag&Drop to the

component or to the Standard Properties Sheet under Data Binding.

By pressing the F5 key, both the range of characters as well as the Additional Properties Sheet can be
reinitialized. This is sometimes necessary when changes in the properties are not adopted directly in the

character range.
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General/Layout Tab
Modules
Here you can see a list of all currently available modules that can be used to design your tiles. The range of

modules is constantly growing with new releases of the graphomate tiles. A detailed guidance on each module and
its options can be found in the description of the Modules tab.

The Lines Module visualizes trends and thresholds with | | e e
two lines. l H ﬁ —
The Bullet Graphs Module shows up to five bullet BULLET BRAPHS i [
graphs after Stephen Few's concept. South East _
. — —
1] 100m 200m
With the Pies Module you can visualize percentages PIES 23 4400
and a deviation in a pie chart. O
Deutschland, Q1, 2015
The Sparklines Module displays up to ten small, Deutschland ©1 2015 &= ——0
individually scaled line charts. i s016 T
The Title Module allows a data-driven definition of two :
title lines and an icon. TITLE @* NEW Tltle ﬂ
Subtitie New Subtitle
The Column Module shows up to three columns with COLUMN 219.0
data labels. B I I J0.0 113.0 -
— .
East Southwest North
The Footer shows a measure with labels in one line. FOOTER 47 1
Net Sales - ACT, West fLMs
B 120
The KPI Module visualizes a measure as large KPI 8
number. 12,3 147; [ I 1 $
The Legend Module shows up to three items for a LEGEND Billed Quantity, South East, Morth Carolina [l
color-based legend. | Aaaa Net Sales, South East, Georgia
Ebbb Billed Quantity, West, Colorado |
The Bars Module shows zeigt analogoug to the BARS -
Columns Module up to three bars with data labels. —
 — Net Sales - ACT,West 47,1m
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The Stacked Column Module shows a data series as a
stacked chart.

The Table Module displays texts and figures in form of
a list.

The Waffles Module displays up to two data series as a
segmented bar chart.

The Icon Module displays a single icon.

The Text Module displays up to three lines of fully
HTML capable text.

This switch can be used to select the face of the tile
to be configured.

Each face has its own configuration. This extends
to modules, databinding, layout as well as layout
options. However, only a single data source is
permitted per tile.

STACKED COLS
Aaaa
Ebbb

TABLE
Aaaa
Bbbb

12,3
45,6

WAFFLES

Data

graphomate tiles

Casa 460,10

Gouthresest £

4,005,923.0
3,616,6862.0

Met Sales/Virginia
Billed QuantityVirginia

ENEEEEEEEEEEEEE
EEEEEEEEEEEEEEE
ENEEEEEEEEEEEEE
ENEEEEEEEEEEEEE
Abszatz

<O

Met Sales, South East, Florida

4,376,319.0 §

N

»

. -
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Builder

Via mouse click you can choose from currently 24
different layouts that consist of up to three lines and
two columns. To set a certain layout just click on
the little grey icon; it then turns blue and the
available layout slots are displayed beneath.

Then simply drag one of the modules above to the
desired row or column of the Builder and drop it
there.

According to the selected module, data connection
and available options are generated in the
background and displayed on the Modules tab.

Please bear in mind that Design Studio allows only
one data source per tile.

Already selected modules can be moved within the
Layout Builder via drag and drop. Assigned data
and other settings are retained.

Modules can be deleted using the button with the
little x in the top right corner of the module icons.

Layout Display Options

Depending on the chosen layout different options
are available here.

For example, the height ratio of the rows to each
other can be adjusted. (A selection of 1:1:1 results
in identical heights of the three rows).)

For layouts that contain more than one column,
there is also the option to adjust the width ratio of
the columns to each other. (A selcection of 1:1
results in identical widths of the two columns.)

The option Show Divider Lines activates thin
dividing lines between the rows of the layout.

Adjust the thickness of these dividing lines via Divid
er Thickness.

Builder

graphomate tiles

Layout Display Options (Front)

Height of First Row
Height of Second Row
Height of Third Row
Hatios Second Row
Show Divider Lines
Divider Thickness (px)

Module Padding (p:x)

11
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Padding allows you to set a uniform distance that
affects each individual module (green highlight in
the figure on the right shows the default setting of 5
pixels). The Padding at this point has no effect on
the dividing lines; for this use the Component
Padding on the Appearance tab (blue highlight).

Internet

Deviation Act. [ Bud, in §

92.521,0

Met Sales

119.005.872,0,

graphomate tiles

11/37


https://graphomate.atlassian.net/wiki/x/H4CCAw

grapho 1] graphomate tiles

Modules Tab

On this tab, data from the chosen data source can

be assigned to the selected modules. The contents Scripting for this module:
of this tab is generated from the modules chosen
on the Layouttab. _getfelection( 'dataSinglelfaelll’,

" {"Keyfigures": "00 NWI IQTY",
) ] . " WWT CHAN™: "4 1%F; =
Due to the dynamic nature of the tiles, the available P

; ; -getbelection( "dateSingleCella’
script commands to control the behavior of the  I"Hayfigqures": 0D WA TOTY".
modules are generated only after the module O MWL CHRAN™- 74717} <
selection. -

-setModulePropercy (1,
" [Measure|Msasure as

measurebisplay”,

The script commands can be found by clicking on Percent |Deviation|Devistion as Percent]’);
the icon. A popup will appear from which the . setModnlebrapertyll, CoanFontSise?
available commands can be marked and copied "100°") ; ; :
with the mouse. Clicking in the Additional Property setModuleDroperty(l, 'incresseIlsGood’,
Sheet outside the popup will let it vanish. "true'};
.getModuleProperty(l, 'showlnits',
"trze"} ;5
-getModuleProperty (1, '"showScalingFactox',
"true");
.getModuleProperty(l, "'metadatsBelow’,
"truae"} ;
With a click on a, you can select data from the Measure Kennzahlen: Met Sales, Region aa
data source to be used with the module. A click on
Code: South East, Area Code:
ﬂ will delete the selection. o o i
Mizsiz=ippi idataSingleCellZ)
To easily identify the assigned data property, its Display-Dimensions Al [ setect
name is displayed in brackets after the dimensions
of the current selection (e. g. dataSingleCell2).
By clicking on m you can choose the Display Title [DIMENSIONS]
Dimensions from the metadata to be used in the
module. Sublitie [DIMENSION1] in [SCALENUMIT)

In certain modules (e. g. Title Module, Footer
Module), these can be addressed via a set of
wildcards. The following wildcards are available: Net Sales - ACT, West

. . sales - AC k
[DIMENSIONS] — shows all dimensions PRI

[DIMENSIONN] — shows the n-th dimension (up to
DIMENSIONG)

[SCALE] - shows the scaling factor
[UNIT] — shows the unit

[VALUE] - shows the value of a single data cell
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Bar Module

North East 2.06m

Central 10.00m

South East 4.38m

Use the Bar Module to display up to three different
measures including category labels and values.
The categories displayed correspond to the
selected Display Dimensions.

Max. Bar Height and Max. Label Height govern the
behavior of the module when the tile is resized,;
bars and labels will scale up to the determined
heights in pixels

If the option Absolute Label Height is activated, the
labels do not scale with the size of the tiles; instead
the entry in Max. Label Height is used as the font
size.

Scaling Helper will display a help line at the
specifiied Scaling Helper Value.

+ 1. Bar Module

Scripting Options [«=1

Display-Dimensions All

Measure 1 (dataSingleCell1)
Measure 2 (dataSingleCell2)
Measure 3 (data3ingleCell3)

Mazx. Bar Height {p:) 30

Max. Label Height (px) | 30
[] Absolute Label Height
[] Scaling Helper

Scaling Helper Value 0

graphomate tiles
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Bullet Graph Module

Connecticut
Met Sales

Florida

Met Sales

Georgia
Met Sales

F
]
3
£
=]

The Bullet Graph Module corresponds to our
graphomate bullet graphs extension. It is based on
Stephen Few’s conceptual considerations regarding
the display of KPlIs.

A detailed description of all parameters would go
beyond the scope of this chapter. We'd like to refer
you to the full documentation of the graphomate
bullet graphs here: de/en.

The following options specifically apply to the
graphomate tiles:

The option Start Element determines the first
element in the assigned data series to be
displayed.

The dropdown box Number of Elements governs
the number of bullet graphs to be displayed.

With the checkbox Display Category Labels, the
headers can either be shown or hidden.

Suppress Sums excludes all sums from the
selected data series.

+ 1. Bullet Graph Module

Scripting Options [«-1
Display-Dimensions All

Ferformance (dataCellList4)
Data 1

FPerormance (dataCellListh)
Data 2

Comparative (dataCellList3)
Data 1

Comparative (dataCellList2)
Data 2

Cualitative (dataCellList1)
Fange

Percentage of Lower
Threshold 0.75

Fercentage of Higher
Threshold 1.25

Start Element 1

Mumber of Elements 3
Category Labels
[] Suppress Sums

graphomate tiles
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Column Module

4.38m

2.06m
1.61m

Connecticut Florida Indiana

Use the Column Module to display up to three
different measures including category labels and
values. The categories displayed correspond to the

* 1. Column Module

selected Display Dimensions. Scripting Options [

Max. Column Height and Max. Label Height govern Display-Dimensions Al m
the behavior of the module when the tile is resized;

bars and labels will scale up to the determined Measure 1 (datasingleCell1) Hn
heights in pixels Measure 2 {dataSingleCell2) Bu
If the option Absolute Label Height is activated, the ) .

labels do not scale with the size of the tiles; instead e (dataSingleCell3) H B
the entry in Max. Label Height is used as the font Mazx. Column Width (px) 30

size.

Checking Scaling Helper will display a help line at Max. Label Height (px) | 30

the specifiied Scaling Helper Value.
1 Absolute Label Height

[1 Scaling Helper
Scaling Helper Value 100

[] Multi Line Category Labels
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Footer KPI Module

Met Sales, California & TZ£/.070s

This module is used to display a single KPI
(Measure) together with its metadata

If an accompanying Comparative Measure is
chosen, the deviation between these two can be
displayed, either as absolute value or percentage.
This can be set with the Value Display option.

You can also use the manual input of values (Manu
al Measure and Manual Comparative Measure);
these fields override the values from the data
assignment.

The input in Text Input is shown in front of the
measure. The metadata from the data source can
be inserted in the text fields with wildcards (see
page 10); by default all dimensions are displayed in
this module.

The checkbox Increase is Good governs whether
positive deviations will be displayed in red or green.

Show Units, and Show Scaling Factor will display or
hide unit or scaling factor from the data source.

graphomate tiles

« 1. Footer KPI Module

Scripting Options [«

Display-Dimensions All m

Measure (dataSingleCell3) H u
Comparative  (dataSingleCell2) H B
Meas

Manual Measure

Manual Comp. Measure

Text Input [DIMENSIONS]
Value Display Measure ﬂ
Increase Is Good
Units
Scaling Factor
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Free Text Module

MNet Sales

12, 371 ,448.0 $

California, West

The Free Text Module shows up to three lines of
plain text. Wildcards can be used to extract and
display metadata. All three text lines support HTML
formatting.

The input boxes Text Line x take one line of text
each.

Fontsizes per row can be adjusted with the
properties Fontsize Line x.

For bold formatting, the checkbox Bold Titles needs
to be activated.

If the checkbox Wrap Texts is activated, texts
exceeding the space limit will be wrapped, resulting
in several lines of texts. Otherwise, they will be
abbreviated with "...".

The dropdown boxes Vertical Position and Horizont
al Position influence the positioning of the text lines
within the module.

Metadata

* 1. Free Text Module

Scripting Options [«

Display-Dimensions All

Text Line 1
Text Line 2
Text Line 3
Fontsize Line 1 {px)
Fontsize Line 2 {px)
Fontsize Line 3 (px)

Bold Texis
Wrap Texts
Vertical Position

Horizontal Position

graphomate tiles

(dataSingleCell2} | x]

First Line
Second Line
Third Line
15

15

15

Top
Left

[<][<]
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Icon Module

The Icon Module can be used to depict a single
icon. This can be chosen from 19 predefined SVG
symbols or the full set of SAP UI5 icons.

Use the dropdown box Icon to choose the desired
icon.

Icon Color governs whether one of the
component-wide colors a an individually
configurable color is used. If "Neutral Color" is
chosen, the "Text Color 2" will be used.

The field SAPUI5 Icon Id allows to insert an icon of
the SAPUIS5 library, for example, e00a for a
synchronize button. To display the icon, select SAP
UI5 Icon under Icon and write the Icon ID into the
appropriate field.

Max. Size is the maximal size of the icon in px. If
the slot is too small, the icon is reduced in size
proportionally.

The dropdown boxes Vertical Position and Horizont
al Position influence the positioning of the text lines
within the module.

In the icon explorer, the SAPUI5 icon ID
could be shown with a prefix for
hexadecimal encoding. The id needs to be
entered without the prefix; please use e. g.
"e00a" instead of "&#xe00a".

graphomate tiles

* 1. lcon Module

Scripting Options [«-1

Display-Dimensions All m

Metadata (dataSingleCell2) E n

lcon Alert V|

Meutral Color ﬂ
Custom Color B

lcom Color

SAPUIE Icon Id

Max. Size (px) a0
Vertical Position Center ﬂ
Horizontal Position Center ﬂ
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KPI Point Module

12.37m:;

The KPI Point Module displays a single measure.
The size of the number is scaled according to the * 1. KPI Point Module
available space.

The options correspond largely with those of the Fo Scripting Options [«

oter KPI Module (see above); in addition, a Max ] o ]

Font Size can be set. The size of the displayed Dizplay-Dimensions Al m
number will not exceed the determined font size. Measure (dataSingleCell2) Hﬂ
The option Metadata Below Value allows to place Comparative datasinaleCell3)

the additional information below the value itself. r'.-1eafure [ g ! H B

Manual Measure

Manual Comp. Measure

Value Display Measure ﬂ
Max Font Size (px) 100

Increase Is Good

Units

Scaling Factor

Metadata Below Value

[
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Legend Module

B Net Sales, California
Met Sales, Florida
B Billed Quantity, Florida

The Legend Module can be used to display up to
three keys together with the assigned colors.

The keys (Entry 1 to 3) can be either entered
manually, or can be generated using the existing
wildcards (see p. 10). If wildcards are used, it is
necessary to assign data first, so metadata are
available.

To hide a key, simply empty the input field.

The colors to be displayed can be defined either
with the dropdown boxes Color Key 1 to 3 (The
colors themselves can be changed on the
Appearance tab.). Alternatively you can choose
own colors with the fields Custom Color 1 to 3 (for
these colors, choose Custom Color in the fields Col
or Key).

The checkbox Bold Text will format the keys in ...
well, bold.

The position of the colored squares can be
determined with the option Colored Boxes. If None i
s selected, no squares are displayed, but the keys
themselves are colored accordingly.

* 1. Legend Module

Scripting Options [«

Display-Dimensions All

graphomate tiles

Datal (datasSingleCell3) HH
Data? (dataSingleCell2) BB
Datal (datasSingleCell1) BB

Entry 1
Entry 2
Entry 3

Color Key 1

Color Key 2

Color Key 3

Custom Color 1

Custom Color 2

Custom Color 3
[] Bold Text

Colored Boxes

Mew Entry 1
Mew Entry 2
Mew Entry 3

Data Color 1 ﬂ
Data Color 2 ﬂ
Good Color ﬂ
u

[ ]
=

Right v
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Line Chart Module

30.00m

20.00m

10.00m

0.00
Jan 09 Dec 08
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The Line Chart Module allows the display of two
data series as lines and an additional Fixed Value,
which can be used as threshold value.

The dropdown box Threshold governs which
measure(s) will be used as threshold value. If a
threshold is chosen, the difference area between Pr
imary Measure and threshold will be displayed
colored. Depending on the selection, either the
differential area between Primary Measure and Sec
ondary Measure or Primary Measure and Fixed
Value is colored.

The thickness of all displayed lines can be changed
with the option Line Size.

If the option Threshold Excess is Good is activated,
and a Threshold is chosen, the positve difference
area is displayed in green, otherwise in red.

The option Display Primary Measure as Area turns
the chart into an area chart.

If activated, Show Value Labels displays the first
and last value of the assigned Primary Measure at
the start and end of the line chart.

Show Category Labels displays the selected
dimensions below the axis; this options works
analogous to Show Value Labels.

Show y-Axis displays a value axis on the left side of
the line chart.

During runtime, Show Click Handlers displays small
circles around possible jump points, when the
mouse pointer hovers somewhere over the module.

Suppress Sums excludes all sums from the
selected data series. As only one data source per
tile is possible, this option can be useful if the sums
are needed in another module, e. g. the KPI
Module.

graphomate tiles

+ 1. Line Chart Module

Scripting Options [«

Display-Dimensions All

Primary (dataCellLizt1)
Measure
Secondary (dataCellLizt2)
Meazure

Fixed Value (datasingleCell1)

Threshold Mone
Line Size {px) 2
Threshold Excess is Good
[] Primary Measure as Area
Value Labels

ategory Labels
Multi Line Category Labels
Value Axis

Visible Click Handlers

I I I O

Suppress Sums

L] x
&
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Pie Module

Met Sales, Apr 09

The Pie Module displays a percentage including a
deviation.

The value for the circle is assigned with the Circle
Data option, Arc Data is used to assign the the
comparative measure, which is displayed as
circular segment. Deviation Data shows a value as
deviation from the Arc Data.

The options Display Category Labels and Display
Values can be used to enhance the graph with
metadata from the data source (Category Labels)
and exact values.

With the checkbox Pos. Deviation is Good, the
interpretation of the deviation can be changed; this
way, negative deviations can be displayed as
positive.

+ 1. Pie Module {Single)

Scripting Options [«

Display-Dimensions All

Circle Data (dataSingleCell1)
Arc Data (dataSingleCell2)
Deviation Data (datasSingleCell3)

Category Labels
Value Labels
Fos. Deviation is Good

graphomate tiles
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Sparklines Module

Alabama N il
Alaska s _
Arkansas NN NN

Califomia  So™ . s

Coloradny gt —]
Connecticut ™~ TN

Florida et
Georgia [
[linois '—n-.v S

The Sparklines Module largely corresponds to our g
raphomate sparklines component. It visualizes up
to ten data series as "word-sized graphics". As per
default, the Sparklines Module uses the full result

set as data input; however, with the E button, a
smaller selection can be made. Minimum and
maximum in each sparkline are depicted as
red/green dots. Each individual sparkline is scaled
to its own minimum and maximum; the two grey
bars in the background of the sparklines give
orientation aid where the depicted data is located in
the overall data set. In the example above, the data
for Arkansas ist located in the upper third of the
result set, whereas Alabama and Alaska are
located near the bottom.

Number of Elements This options governs the
number of lines of data that are used to generate
sparklines.

The entry in Start Element governs the first element
in the input data to be displayed. Ife. g. a5 is
entered, the first sparkline is generated from the
fifth line of data, lines 1 to 4 are left out.

With the option Display Category Labels, category
labels in front of the sparklines can be toggled on or
off.

Suppress sums excludes sums from the data to be
displayed.

Data in Rows governs whether the input result set
is interpreted in rows or columns.

* 1. Sparklines Module

Scripting Options [«-1

Display-Dimensions All

FesultZet (dataSet)
MNumber of Elements
Start Element

Category Labels

[] Suppress Sums

Data in Rows

graphomate tiles
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Stacked Column Module

South East 200.07m

B \West 47.13m

Central 147.82m
== North East 22.02m

Summe 417.04m

Use the Stacked Column Module to display a data
series as a stacked chart. The categories displayed
correspond to the selected Display Dimensions.

Column Width, Max. Label Height and Absolute
Label Height work analogous to the Columns or Bar
Module.

If the option Graded Colors is activated, the stack
elements are no longer colored monochrome with
white dividing lines, but as color gradations of Data
Color 1 (defined on the Appearance Tab).

If Negative Stacks is activated, and the connected
data series contains negative values, these are
sorted to be at the bottom of the stacked bar. In
addition, a small indicator is displayed at the
baseline.

graphomate tiles

+ 1. Stacked Column Module

scripting Cptions [«
Display-Dimensions All
(dataCellList2)

Measure 1
Column Width {px) 30
Max. Label Height (px) | 30

[1 Absolute Label Height
Graded Colors

O

[0 Megative Stacks
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Table Module
Alabama 5 316,76k
Alaska 438 50k
Arkansas 113.21m
California 12.37m
Colorado 675 17k
Connecticut 2.06m
Florida 4.38m
Georgia 1.79m

The Table Module can be used to display several
measures in a tabular form, either as absolute
values or percentage.

Color Display governs the text color of the table.

The option Start Element can be used to determine
the first element in the data series to be displayed.
If e. g. a 5 is entered, the table starts with the 5th
element in the data series; elements 1 to 4 are
skipped.

Number of Elements narrows the displayed
elements to the number entered.

With Max. Font Size, the maximal font size is
determined; up to this value (in pixels), the text will
scale with the tile.

If the options Show Units or Show Scaling Factor ar
e active, the table will show these preceding the
first value, provided they are contained in the data
source.

For ease of reading, the option Alternating
Background Color can be used to toggle light-grey
bars in the background of every other line.

graphomate tiles

+ 1. Table Module

Scripting Options [«=1

Display-Dimensions All m
Values (dataCellList2) n H

Value Display Measure ﬂ
Color Display Data Color 1 | V|
Start Element 1

Mumber of Elements 5
Max Font Size (px) 12

[1 Units

Scaling Factor

[

[] Alternating Background Color
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Title Module

Net Sales, Arkansas *

Mew Subtitle

The Title Module is text component with either one
or two rows, and an optional icon.

As described above, the metadata from the data
source can be inserted in the text fields with
wildcards; alternatively, the texts can be entered
manually.

For bold formatting, the checkbox Bold Titles needs
to be activated.

If the option Absolute Label Height is activated,
both lines of text use the global fontsizes
(Appearance Tab). If the option is deactivated, the
text size is scaled down if necessary.

The Icons to be displayed in the right of the module,
as well as their color, can be set either manually or
via scripting. To choose manually, select the
desired icon from the dropdown box. The size of
the displayed icons scales with the font sizes of title
and subtitle. These can be set in the Appearance
tab.

The field SAPUI5 Icon Id allows to insert an icon of
the SAPUIS5 library, for example, e00a for a
synchronize button. To display the icon, select SAP
UI5 Icon under Icon and copy the Icon ID into the
appropriate field.

If Absolute Label Height is deactivated, the
option Wrap Title is ignored; also, inline
HTML tags will not be interpreted.

In the icon explorer, the SAPUI5 icon ID
could be shown with a prefix for
hexadecimal encoding. The id needs to be
entered without the prefix; please use e. g.
"e00a" instead of "&#xe00a".

graphomate tiles

+ 1. Title Module

scripting Options [«

Display-Dimensions All m

Metadata (dataSingleCell3) (.| x]
Title MNew Title
Subtitle Mew Subtitle

[] Bold Titles

Absolute Label Height

[0 Wrap Title
lcon Mone ﬂ
lcon Color MNeutral Color ﬂ
Custom Coler B

SAPUIS lcon Id
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Waffle Module

Connecficut, Met Sales

Florida. Met Sales
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The Waffle Module depicts up to two data series as
segmented stacked bars ("waffles").

The option Display Values toggles the display of the
underlying values.

With Display Category Labels, category labels can
be toggled on or off.

Number of Elements This options governs the
number of lines of data that are used to generate
waffle bars.

The entry in Start Element governs the first element
in the input data to be displayed. Ife. g. a5 is
entered, the first bar is generated from the fifth line
of data, lines 1 to 4 are left out.

Suppress sums excludes sums from the data to be
displayed.

The option Axis Alignment governs whether the
bars are aligned with the left component border
("Leftbound"). If "Center" is chosen, the 0-axis is
located in the center; in this case, the bars will be
drawn from the center to the left and to the right.

With the option Calculation Base, the interpretation
of the input data as either absolute or percentual is
determined.

The value Units per Box is only used if "Absolute" is
chosen as Calculation Base. It is used as
calculation basis for a single box in the waffle
pattern. If e. g. a value of 4500 is to be depicted,
and 100 is specified as Units per Box, the bar will
contain 45 little squares; an input of 1000 results in
4.5 squares.

The value in Percent per Box is applied if
"Percentage” is chosen as Calculation Base. In this
case, the sum of both data series for each pair of
bars is interpreted as 100%; an input of 1 results in
100 boxes for both series, an input of 5 results in 20
boxes for both series.

graphomate tiles

1. Waffle Module

Scripting Options [«

Display-Dimensions All

Primary (dataCellList2)
Measure
Secondary (dataCellList1)
Measure

[] Walue Labels
Category Labels
Mumber of Bars 3

Start Index 1

[] Suppress Sums

Axis Alignment Center
Calculation Base Ahsolute
Units per Box 1
Fercent per Box 1

<[«
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Appearance Tab

Font Sizes
In this section, the font sizes used throughout the = / j/
tiles component can be adjusted. All inputs are in
pixels. Likewise, the font family can be changed Appearance
here.
Font Sizes
Headlines {px)
Regular Text (px)
Labels {px)
FontFamily
Padding

The padding defined here affects the space
between the border of the overall component and
the modules contained within (blue frame in the
picture on the right). Thus, it also effects the divider
lines between the modules. Individual module
paddings can be adjusted on the General/Layout ta
b.

Padding (px)

Border Size (px)

Border Size

This property governs the border size of the
component. If a border size of 0 is specified, no
border will be displayed.

Grid

The option Snap to Grid activates a grid function; if Grid
checked, the size of the drawing area can only be
changed in the intervals determined in the Grid Size

input field. Grid Size (px)

[] Snap To Grid

graphomate tiles
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Color Configuration

The general color configuration is defined in this
section. In this way, the consistent appearance of
all modules in a given tile is ascertained. Adjustable
are the colors for good and bad values, two text
colors and two data colors as well as the color of
the component border which also affects the slot
divider lines.

Value Format

In this section, the format of all value labels is
determined:

® Basic
Here, you can change the presets for absolute
and percentage value according to numeral.js.
Locale changes the country setting. If set to AU
TO, the country setting will be governed by the
data source.

* Extended
If a fixed format is desired for the value labels,
this can be done with the extended number
format. The resulting format string can be set
via scripting as well. See Number Formatting

graphomate tiles

Color Configuration
Good

Bad

Text 1
Text 2
Data 1
Data 2

EfEEEERN

Component Border

Value Format

- Extended

Percentage 0.0%
Absolute 0,0.0

Forrnaf sinng according fo numersl js

Locale an ﬂ

Value Format

abs %%
Decimal Separator

Thousands Separator

(<< <] <]

Megative Sign -

Scaling 1 1
Decimal Places 1 1
Prefix

Suffix %

K<< [<] €]
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Behavior Tab

Scaling A .
In this section, the scaling mode can be changed. If = / j/ v I
set to Auto, each module will be scaled according

to the minima and maxima of the selected module; Behavior

scaling will usually start at 0. The setting Manual
enables you to enter particular minimum and

) Scaling
maximum values.
If the scaling is set to Auto, the tile can be - Manual
registered in a Comparison Group by activating the
checkbox. If active, the Comparison Group will [] Comparison Group

govern scaling; all components within this
comparison group will be scaled identically and an
indicator of the comparison group is shown during
design time.

E C D E F G H

Within the BIApp, comparison groups are used
globally, i. e. graphomate tables, graphomate
charts and graphomate bulletgraphs which are part
of the same comparison group will be scaled
identically.

Note: pie modules are scaled according to their
surface and are not compatible to other modules
and or components within the same Comparison
Group. Therefore It is advisable to use a separate
Comparison Group for tiles containing pie modules.
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Flip
In this section, the flip effect of the tile can be [] Flip Effect
configured.
Double Click  Hover
The dropdown box Flip Effect governs whether the -

tile can be flipped or not. Flip Duration (ms) 250

The control element beneath can be used to select
the desired flip action.

Flip Duration governs the animation duration in
milliseconds. If e. g. a 1000 is entered, the
animation will last for one second.

If the flip effect should only be triggered on a
specific module, this can be realized with a small
script in the On Component Selected event:

i f (GRAPHOVATETI LE_1. get Sel ect edModul e

() ==
1) { GRAPHOVATETI LE _1.toggl eFlip();}
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Info Tab

This section contains information about the installed —

. : ) A .
version of graphomate tiles as well as a link to a [ ] / ’/ v ."
feedback form on our website. f—

The Credits contains an overview of the used Info

ibraries. graphomate -II %

tiles Version: 2.0.0.7 Build: 201708231513 (IE 11)

Flease use this link to submit errors or ideas for
improvement.

The General Terms of Licence and Maintaining of the
graphomate GmbH apply.

@ 2017 graphomate GmbH, D-Kiel,
www.graphomate.com

Credits

P more
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Number Formatting

Possible Input for The numeral.js Format String

Number

10000

10000.23

-10000

-0.23

-0.23

0.23

0.23

1230974

1460

1

Number

1.000.234

1000.2

1001

Number

1

-0.43

Source

Format String
'0,0.0000'

'0,0"

'0,0.0'

*.00'

'(.00)'
'0.00000'
'0.0[0000]'
'0.0a’

0 a

|OO|

Format String
'$0,0.00'
0,0[.]00 $'

'$ 0,0[.]00'

Format String
IO%I

IO%I

Output
10.000,0000
10

-10.000,0
-,23

(.23)
0,23000
0,23

1,2m

1k

1St

Output
$1.000,23
1.000,20 $

$1.001

Output
100%

-43%

graphomate tiles
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Possible Input for The Extended Number Format String

Percentages and absolute numbers are formatted separately. For this two format strings are used, which follow the
same rules and structure. In general the strings of characters in the format string are simply replaced in the input
number. Exceptions to this rule would be scaling factors and the number of decimal places.

The elements of the format string are separated by the "|" character. Format strings with less than 7 elements (or 6
"|" characters) are considered invalid and therefore ignored. In this case the standard format without scaling and with
one position after the decimal point is used.

The format string consists of the following elements, the ordering is obligatory and cannot be changed:
Negative|Prefix| Thousands|Decimal|Scaling|PointsAfterDecimal|Suffix

Negative

Prefix

Thousands
Decimal

Scaling

PointsAfterDecimal

Suffix

The prefix for negative numbers. The string "()" will result in the number placed inside
parentheses, including eventual prefixes and suffixes. If None is used, the absolute number
will be shown.

A prefixed string of characters, for example a currency symbol or an identifier for the scaling
factor.

A separator for thousands.

A separator for the decimal places.

The scaling factor for the value. This can be given as a whole number or a power, formatted
as n“m. A whole number will be calculated as a power to the basis 10 internally. In case of a
given power the value will be divided by it directly. Even negative humbers are possible, for
example "-3" or "107-3"; in this case the value will get adequately higher. Non numeric

inputs are ignored. Please note: given a "0" or a "1" will result in a scaling factor of 1. The
only way to achieve a scaling by 10 is to set the input to "1071".

The number of places after the decimal.

A suffix for the value, analogous to the prefix.
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CSS Selectors

Overview of css classes

The following illustrations provides some of the css selectors, which can be adressed by using the Costum CSS in
SAP Lumira Designer.

|~ gm_tiles_lineChartLine

- -6,000.0 l HB.EGE 0
|

Internet |—.gm_tiles_legendicon
.gm_scaledTextsContentSvg ——b1 1 2 9 ' I I PCS .- 3'.‘:“;3;. a

Musskuchan Musskuchan

.gm_tiles_titleModuleHeading #GRAPHOMATETILE_2_control .gm_tiles_lineChartvalueText
fil)fill
I’ ‘ .'ll' fill-stroke .gm_linechart \icon
\
[ \ |
. b .
Billed Quantity Net Sales ;&; Net Sales
.gm_tiles_titleModuleSubheading — intemet, Summe Internet vs. Phone, All Regions Interijel, West
|

/

Internet Kosten Kostan
2015[2015 201€[2016 r.gm_tiles_legendText
N
— |
.gm_tiles_footerkpiModuleLabel —% Tear to Date v -11.5% e Gaz015 f 17,616.0
. . " . .
.gm_tiles_layout_slot_0 0“—"" .gm_tiles_horizontalDivider Billed (Juanmy - BI||%QLI3HIIW \4
- = — == - Net Sales, Major Regions West, Qimension not found
162.7m
.gm_tiles_layout_slot 1 0 ~_| — Sputh East .
‘\ —.gm_tiles_pieModuleArc
.gm_tiles_layout_slot_1 1————"" | West +.gm_tiles_pieModuleDeviation
__ Central | __gm_scaledTextsContentSvg
-gm_tiles_layout_slot_2 0 ._ | ' North East
Ma /
L )
.gm_tiles_layout_slot_2_1— /' ‘iear o Date A +35.3% vear In Date 44.3m
.graphomateCompanentBorder / .gm_tiles_footerkpiModuleTrendsign
.gm_tiles_verticalDivider .gm_tiles_stackedBarRect .gm_tiles_footerkpiModulevalue .gm_scaledTextsContentSvg
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